
Uncle Sam (Step by Step) 
 
Open the file tools.psd (file name may vary). 
 
Make sure you have the LAYERS palette open. 
(Window -> Layers) 
 
In the layers palette click the layer (make it blue or highlighted) that contains the photo 
uncle sam.  It is the layer numbered 1. 
 
Next do <CTRL><A> to select the entire image.  You will see ants marching around the 
perimeter of the image. 
 
(You may not see the actual photo of uncle sam if you did not turn off all the eyeballs 
(they indicate layer visibility) above this layer.  But since you did select the layer 1 by 
clicking on it (making it blue/highlighted) you will copy it.  That is you don't have to see 
the picture to copy it.) 
 
<CTRL><C> copies the image to the operating system's (win9n, mac, whatever) 
clipboard. 
 
<CTRL><N> creates a new document window.  It's dimensions (length, width, dpi) will 
correspond to the picture you copied.   
 
Click OK. 
 
<CTRL><V> to paste the copied image into the new document. 
 
Next click back on the original file tools.psd and click the small <X> in the red box in the 
upper right corner of  the image. This closes the original file.  If it asks if you want to 
save any changes click NO. 
 
At this point the only image on your Photoshop desktop should be Untitled-1.  It should 
have the picture of uncle sam and “family”.  The layers palette should have two layers in 
it.  One called Background and the other called Layer 1. 
 
At the top of the layers palette just below the x in the red box there is a right facing 
triangle.  Click it and choose "flatten image".  Now the Layers palette should have only 
one layer called Background. 
 
Next we will crop the image.  We don't need the border because there is no real 
photographic information there and we will replace it latter. 
 
<C> will highlight the crop tool.  Make sure the options palette is cleared of width, 
length, dpi information.  We don't want to change any of the pixels if we can help it. 
 



You may start anywhere but for unity let's start in the upper left corner of the picture.  
Using the mouse, position the cursor in the upper left corner of the photo and click the 
left mouse button and hold the button in the down position.  With the button held down 
drag the cursor diagonally down the picture to the lower right corner.  A box should trace 
your movement.  This is called a bounding box.  At the bottom right corner of the picture 
release the left mouse button.  The position is not critical.  When you release the mouse 
button you will see marching ants surround the picture and 8 small boxes.  You can click 
in these boxes and move then to make adjustments to the crop.  Holding the <SHIFT> 
key and dragging a corner square will keep the proportion even.  Not necessary in this 
example. 
 
When you are satisfied double click in the box or hit the <ENTER> key. 
 
Let's start cleaning up the image. 
 
<CTRL><SHIFT><B> will do an "auto color correct".  This may help.  If not do a 
<CTRL><Z> to remove or "undo" the correction made.  Remember the <CTRL><Z> 
undoes the last step you made.  It will toggle between the step you are on and the one 
before it.  <CTRL><ALT><Z> will allow you to step back one state change (action you 
preformed) at a time.  If you look at the "History" palette (window -> History) you 
should see 5 actions: 
 
New,  Paste,  Flatten Image, Crop, and Auto Color. 
 
Go ahead and try the <CTRL><ALT><Z> keys and step back through the steps.  When 
you get to New do <CTRL><Z> a couple of times.  Neat! 
 
Let's de-saturate the image now, <CTRL><SHIFT><U> (image->adjustments-
>hue/saturation). 
 
Using the clone tool <S> clean up the scratches and other problems.  Remember that you 
must tell the clone tool where it is to copy pixels from before it can work.  So 
<ALT><CLICK> on a clean spot and then brush out the problem spots. 
 
The brush size can be controlled with the "Alice in Wonderland" keys <[><]>. The 
left one makes you smaller and the right one makes you large but the ones 
mother gives you ... . 
 
If you use the <SHIFT> key with the square bracket you can make your brush hard <]> 
or soft <[>.  This is controlling the feather. Soft helps blend the cloned pixels into the 
blemish or area to be filled by these filters. 
 
Now we are ready to replace the “sky”.  <W> for the "magic wand" and set the tolerance 
in the options palette, at the top of the screen to 32.  Why 32?  I just like that number.  It 
is not the answer to the base question.  That is 42.  Click in the ““sky”” to the left of the 
Saguaro. Then either hold the <SHIFT> key or click the 2nd box from the left of the 4 



boxes on the left side of the options palette.  This is the add to selection command. Next 
click with the "wand" in the upper part of the Saguaro to get  
 
the little piece of “sky” up there. Finally click (with the 2nd box still set or holding the 
<SHIFT> key) the right part of the “sky” with the magic wand. 
 
The “sky” is selected.  However, you will probably have some of the cactus selected as 
well as parts of the people in the picture.  The wand could not differentiate between the 
light colored shirt and the “sky”. 
 
So now we will de-select those parts of the picture that are not a part of the picture.. 
 
<L> for the lasso.  Make sure it is the freeform "Lasso Tool" (the top one in the lasso tool 
drawer. 
 
Either hold the <ALT> key or click the 3rd box from the left of the 4 boxes on the left 
side of the options palette.  This is the subtract from selection command. 
 
 
For unity let's start with the upper part of the cactus. Holding the 
<CTRL><SPACEBAR> down your lasso cursor will turn into a magnifying glass with a 
plus (+) sign in it (don't forget to look at the right click option at this point).  Like the 
crop tool let's start above and to the left of the cactus arm and draw in a diagonal 
direction toward the button right to just bellow where the arm of the cactus meets the 
trunk (I am assuming it is called a trunk but I would call a clapper rail a brown bird). You 
should have an enlarged view of the marching ants at this point.   
 
Using the lasso <L> start in the arm of the cactus and draw a line up the edge of the 
cactus through the ants already there and loop it back down through the arm to the point 
where you started.  At this point you should have that corner of the “sky” well defined.  
You can add to and subtract from the selection (marching ants) as much as you need to. 
 
<CTRL><SPACEBAR> and right click in the picture. Choose "Fit on Screen".   
 
Now you will use the same techniques outlined above (starting with "Now we are ready 
to replace the “sky”") to clean up the people. 
 
Once you have the “sky” well defined save the selection and then save the picture as a 
PSD. 
 
Select -> Save selection -> Name -> “sky”  -> OK <CTRL><SHIFT><S> (File -> Save 
As) and name it uncle.psd <ENTER> To see the selection you just saved Window -> 
Channels.  It should be at the bottom and called “sky”. If you kill the selection or close 
the file you can recall it by opening the channel palette and <CTRL><CLICK>ing the 
channel called “sky”.  Try this.  Do <CTRL><D> to deselect the ants and 
<CTRL><CLICK> the channel “sky” to make them reappear. Really neat! 



If your image turns into a high contrast black and white photo you may have used the 
<ALT> key instead of the <CTRL> key or simply clicked the channel by itself.  No 
harm.  Just click the top channel RGB and try again. 
 
Using the PSD file type allows you to save and reuse the selection you made of the “sky”.  
Selections can't be saved in JPEG or GIF formats.  TIFF will work. 
 
Now find the file "Dune.jpg" (<FLAG><F> and search). When you find it just click and 
drag it onto the Photoshop desktop.  You may have to make the find window and the 
Photoshop window a little smaller in order to see both of then. 
 
With the Dune.jpg highlighted (blue bar (in most cases) at top of picture) <CTLR><A> 
to select the whole picture and <CTRL><C> to copy it to the clipboard.  Then move the 
Dune.jpg to the side and make the picture uncle.psd active (blue bar (in most cases) at top 
of picture).  <CTRL><V> to paste the Dune picture onto uncle.psd 
 
It will probably not fit properly.  Don't worry be happy!   
 
Click back on the Dune.jpg file (blue bar (in most cases) at top of picture) and then close 
it. 
 
Do a <CTRL><D> to make sure you have de-selected the image.  Remember the 
selection is saved in the channels palette.  Window -> Channels 
 
Layer check!  At this point check the Layers palette and be sure there are only 2 layers 
there, Background and Layer 1.  Double click on the words "Layer 1" in the layers palette 
and it should become editable.  Type in the word “sky” and hit <ENTER>. 
 
Do <CTRL><T> and using the 8 small square boxes surrounding the dune drag them 
until the “sky” covers the top half of  uncle.psd.  Bigger is better.  You want all the “sky” 
in the old picture (uncle) to be covered with bright blue “sky” from the new picture 
(dune). 
 
If you can't see the complete bounding box <ALT><SPACEBAR> (magnifying glass 
with a minus (-) sign in it) and click in the picture to reduce its size.  Click as many times 
as you need to. 
 
Once the “sky” pretty much fills the image double click on the “sky” or hit the 
<ENTER> key. 
 
Now we must convert the layer called Background from a special layer into a regular 
layer.  In the layers palette double click the Background layer.  A box will pop up "New 
Layer" with the Name: defaulting to Layer 0.  Change Layer 0 to “family” and hit <OK> 
or <ENTER>.  You should see “family” at the bottom of the layer's palette and “sky” 
above it. 
 



With your mouse move the cursor over the layer “sky” and it (the cursor) should change 
into a hand. Click (left button) and drag the layer “sky” below “family” and let go of the 
mouse button. Wow!  Try it a few times rotating the “sky” and “family” layers.  Try the 
<CTRL><Z> command a few times watching the layer's palette and the actual picture.  
 
 Neat! 
 
Remember to leave the layer with “sky” on the bottom and “family” on the top. 
 
We must now reload the selection we had saved earlier. 
 
On the channel's palette <CTRL><CLICK> channel “sky”.  The marching ants should 
appear on the picture.  For the most dramatic and awe inspiring effect you should hide 
(but don't forget you hid it) the selection,  <CTRL><H>. Curl your toes and get ready. 
Then click <DELETE>.  No expletives needed here.  I can already hear the OOHs and 
AHs. 
 
Let’s crop the picture to a standard size (not absolutely necessary odd sizes are fine) and 
add a new beautiful border. 
 
First kill the selection <CTRL><D>. 
 
Click <C> for the crop tool and set the length and width variables in the crop tool’s 
options palette at the top of the Photoshop desktop.  For unity let’s create an 8” x 10” 
print.  Set the crop size options to a little less then the actual print size.  For this example 
I am going to use 7.5” for the width and 9.5” for the height.  This will give us a quarter 
inch border around the photo.  I will leave the resolution blank.  I want to keep the pixels 
as close to the original image as I can. 
 
Starting at the upper left (for unity) click and hold the left mouse button and then drag the 
cursor to the bottom right.  The crop tool will stop at the right side of the picture.  If you 
accept this crop you will crop the people very close.  So hold the <SHIFT> key (holds the 
crop box straight while moving it – try moving it without holding <SHIFT>) and drag it 
toward the bottom of the image.  Double click inside the crop box or hit <ENTER>.   
 
Right click on the blue bar (in most cases) at top of picture and choose “Canvas Size”.  
Change the width to 8 inches and the height to 10 inches.  Click OK. Remember to 
change your background color to white or whatever color you want to make the border.  
The Photoshop default for the foreground / background colors are black and white 
respectfully.  The shortcut for this is <D> and to swap them hit <X>.  To change to 
another color click the background color icon and choose the color. To change the hue 
(the named color like red or blue) use the slider and then click the intensity of the color 
you want to use inside the big box.   
 
If you don’t see ”the blue bar (in most cases) at top of picture”  look at the upper right 

side of Photoshop.  You will see 3 boxes,  —    
—   X  (the X is in a red box).  Under 



these 3 boxes  should be 3 more boxes,    —    
—   X.  Click the middle icon  

—  
and the 

blue bar should be visible. 
 
The only thing left to do is save the file using a new name.  You don’t want to 
<CTRL><S> because you want to keep the restored picture as it is, not cropped.  Then 
you can resize it latter to any size you choose.  So <CTRL><SHIFT><S> and give it a 
name.  Click OK. 
 
Try changing the border color and play with the crop tool.  Play with all the tools.   
 
Remember 
 

<CTRL><Z> and <CTRL><SHIFT>Z> 
 
Enjoy!  


